Installation Guide

PTP 820 NMS
System Release R18A00
Accuracy

While reasonable efforts have been made to assure the accuracy of this document, Cambium Networks assumes no liability resulting from any inaccuracies or omissions in this document, or from use of the information obtained herein. Cambium reserves the right to make changes to any products described herein to improve reliability, function, or design, and reserves the right to revise this document and to make changes from time to time in content hereof with no obligation to notify any person of revisions or changes. Cambium does not assume any liability arising out of the application or use of any product, software, or circuit described herein; neither does it convey license under its patent rights or the rights of others. It is possible that this publication may contain references to, or information about Cambium products (machines and programs), programming, or services that are not announced in your country. Such references or information must not be construed to mean that Cambium intends to announce such Cambium products, programming, or services in your country.

Copyrights

This document, Cambium products, and 3rd Party software products described in this document may include or describe copyrighted Cambium and other 3rd Party supplied computer programs stored in semiconductor memories or other media. Laws in the United States and other countries preserve for Cambium, its licensors, and other 3rd Party supplied software certain exclusive rights for copyrighted material, including the exclusive right to copy, reproduce in any form, distribute and make derivative works of the copyrighted material. Accordingly, any copyrighted material of Cambium, its licensors, or the 3rd Party software supplied material contained in the Cambium products described in this document may not be copied, reproduced, reverse engineered, distributed, merged or modified in any manner without the express written permission of Cambium. Furthermore, the purchase of Cambium products shall not be deemed to grant either directly or by implication, estoppel, or otherwise, any license under the copyrights, patents or patent applications of Cambium or other 3rd Party supplied software, except for the normal non-exclusive, royalty free license to use that arises by operation of law in the sale of a product.

Restrictions

Software and documentation are copyrighted materials. Making unauthorized copies is prohibited by law. No part of the software or documentation may be reproduced, transmitted, transcribed, stored in a retrieval system, or translated into any language or computer language, in any form or by any means, without prior written permission of Cambium.

License Agreements

The software described in this document is the property of Cambium and its licensors. It is furnished by express license agreement only and may be used only in accordance with the terms of such an agreement.

High Risk Materials

Cambium and its supplier(s) specifically disclaim any express or implied warranty of fitness for any high risk activities or uses of its products including, but not limited to, the operation of nuclear facilities, aircraft navigation or aircraft communication systems, air traffic control, life support, or weapons systems (“High Risk Use”). Any High Risk is unauthorized, is made at your own risk and you shall be responsible for any and all losses, damage or claims arising out of any High Risk Use.
Contents

About This User Guide
Contacting Cambium Networks
Purpose
Cross references
Feedback
Problems and warranty
Reporting problems
Repair and service
Hardware warranty
Security advice
Warnings, cautions, and notes
Warnings
Cautions
Notes
Caring for the environment
In EU countries
In non-EU countries
Chapter 1: About PTP 820 NMS
PTP 820 NMS functionality
Installation Guide
More information
Chapter 2: PTP 820 NMS Installation
PTP 820 NMS Installation on Windows
Database Installation
Oracle
PostgreSQL
PTP 820 NMS Windows Installation
NMS Server Pre-installation for Windows
PTP 820 NMS Installation for Windows
System Manager Installation on Database Server
Upgrade PTP 820 NMS Windows Installation
Uninstall PTP 820 NMS for Windows
PTP 820 NMS Installation on Solaris
PTP 820 NMS Pre-installation for Solaris
PTP 820 NMS Server Installation for Solaris

Phn-3991_004v001
Page i
List of Figures

Figure 1 Oracle Create as Container database ................................................................. 2-5
Figure 2 PostgreSQL Properties ....................................................................................... 2-9
Figure 3 Oracle Max Connections .................................................................................. 2-10
Figure 4 PTP 820 NMS Server High Availability Primary IP address ............................... 2-11
Figure 5 Internet Explorer File Download ..................................................................... 2-15
Figure 6 Internet Explorer Security Warning ................................................................. 2-15
Figure 7 PTP 820 NMS Installation ............................................................................... 2-16
Figure 8 License Agreement .......................................................................................... 2-17
Figure 9 Choose Install Set ............................................................................................ 2-18
Figure 10 PTP 820 NMS Installation .............................................................................. 2-19
Figure 11 Choose Install folder ...................................................................................... 2-20
Figure 12 Choose Shortcut Folder .................................................................................. 2-21
Figure 13 Pre-Installation Summary ............................................................................. 2-22
Figure 14 Installing PTP 820 NMS ............................................................................... 2-23
Figure 15 Install Complete ............................................................................................. 2-24
Figure 16 Start System Manager Session ...................................................................... 2-25
Figure 17 Database backup and restore operations ......................................................... 2-28
Figure 18 Installation wizard - Introduction .................................................................. 2-30
Figure 19 Installation wizard – License agreement ......................................................... 2-30
Figure 20 Installation wizard – Choose install set .......................................................... 2-31
Figure 21 Installation wizard – Choose shortcut folder .................................................. 2-32
Figure 22 Installation wizard – Choose shortcut folder .................................................. 2-33
Figure 23 Installation wizard – Choose shortcut folder .................................................. 2-33
Figure 24 Installation wizard – Installing PTP 820 NMS ............................................... 2-34
Figure 25 Installation wizard – Install complete ............................................................. 2-35
Figure 26 NMS System Manager ................................................................................... 2-36
Figure 27 PTP 820 NMS Uninstaller wizard ................................................................. 2-38
Figure 28 PTP 820 NMS Uninstaller confirmation dialog ............................................... 2-38
Figure 29 PTP 820 NMS Uninstall complete ................................................................. 2-39
Figure 30 System Manager in standalone mode ............................................................ 2-49
Figure 31 Pre-installation Summary .............................................................................. 2-51
Figure 32 System Manager ............................................................................................ 2-53
Figure 33 NMS Server Settings .................................................................................... 2-59
Figure 34 Import License window .................................................................................. 2-61
Figure 35 License Administration tab ............................................................................ 2-63
Figure 36 License installation when upgrading license capabilities ................................. 2-63
Figure 37 License installation following hardware replacement ................................................................. 2-64
Figure 38 User/Schema Parameters page .................................................................................................... 3-69
Figure 39 Start NMS Server checkbox .......................................................................................................... 3-70
Figure 40 Database Connection Parameters page ......................................................................................... 3-71
Figure 41 Database server address field ...................................................................................................... 3-72
Figure 42 NMS HA View of the Primary server’s System Manager ................................................................. 3-73
Figure 43 Set Active User/Schema ................................................................................................................. 4-81
Figure 44 Database Connection Parameters page ........................................................................................ 4-82
Figure 45 Database Install Path page ............................................................................................................ 4-83
Figure 46 Backup Active User Schema ......................................................................................................... 4-86
List of Tables

Table 1  Required minimum values for running PTP 820 NMS with PostgreSQL ............................................... 2-10
Table 2  NMS Install Units .......................................................................................................................................... 2-13
Table 3  MMS Install Sets ........................................................................................................................................ 2-14
Table 4  NMS install sets ........................................................................................................................................... 2-41
Table 5  NMS all install sets ...................................................................................................................................... 2-42
Table 6 Towards the PTP 820 NMS server ........................................................................................................ 2-54
Table 7 Towards the NE ............................................................................................................................................. 2-54
Table 8 Towards the PTP 820 NMS server if FTP is used ..................................................................................... 2-54
Table 9 Towards the PTP 820 NMS server if SFTP is used ..................................................................................... 2-55
Table 10 Towards the PTP 820 NMS database machine ...................................................................................... 2-55
Table 11 Towards the System Manager installation .......................................................................................... 2-55
Table 12 Reserving ports on the machine hosting the PTP 820 NMS server .................................................... 2-56
Table 13 Reserving ports on the machine hosting the System Manager ............................................................ 2-57
Table 14 PTP 820 NMS modules ............................................................................................................................ 2-57
Table 15 PTP 820 NMS Server Recommended Settings .................................................................................... 2-59
About This User Guide

This guide contains the following chapters:

- Chapter 1: About PTP 820 NMS
- Chapter 2: PTP 820 NMS Installation
- Chapter 3: PTP 820 NMS Server High Availability
- Chapter 4: PTP 820 NMS Database High Availability

Contacting Cambium Networks

Support website: http://www.cambiumnetworks.com/support
Main website: http://www.cambiumnetworks.com
Sales enquiries: solutions@cambiumnetworks.com
Support enquiries: support@cambiumnetworks.com
Repair enquiries: rma@cambiumnetworks.com
Telephone number list: http://www.cambiumnetworks.com/support/contact-support

Address: Cambium Networks Limited,
Global Headquarters
3800 Golf Road,
Suite 360
Rolling Meadows,
IL 60008 USA
Purpose

Cambium’s PTP 820 Network Management System (NMS) documents are intended to instruct and assist personnel in the operation, installation and maintenance of the Cambium equipment and ancillary devices. It is recommended that all personnel engaged in such activities be properly trained.

Cambium disclaims all liability whatsoever, implied or express, for any risk of damage, loss or reduction in system performance arising directly or indirectly out of the failure of the customer, or anyone acting on the customer’s behalf, to abide by the instructions, system parameters, or recommendations made in this document.

Cross references

References to external publications are shown in italics. Other cross references, emphasized in blue text in electronic versions, are active links to the references.

This document is divided into numbered chapters that are divided into sections. Sections are not numbered, but are individually named at the top of each page, and are listed in the table of contents.

Feedback

We appreciate feedback from the users of our documents. This includes feedback on the structure, content, accuracy, or completeness of our documents. Send feedback to support@cambiumnetworks.com.

Problems and warranty

Reporting problems

If any problems are encountered when installing or operating this equipment, follow this procedure to investigate and report:

1. Search this document and the software release notes of supported releases.
2. Visit the support website.
3. Ask for assistance from the Cambium product supplier.
4. Gather information from affected units, such as any available diagnostic downloads.
5. Escalate the problem by emailing or telephoning support.

Repair and service

If unit failure is suspected, obtain details of the Return Material Authorization (RMA) process from the support website.
Hardware warranty

Cambium’s standard hardware warranty is for one (1) year from date of shipment from Cambium Networks or a Cambium distributor. Cambium Networks warrants that hardware will conform to the relevant published specifications and will be free from material defects in material and workmanship under normal use and service. Cambium shall within this time, at its own option, either repair or replace the defective product within thirty (30) days of receipt of the defective product. Repaired or replaced product will be subject to the original warranty period but not less than thirty (30) days.

To register PTP products or activate warranties, visit the support website. For warranty assistance, contact the reseller or distributor.

Caution

Using non-Cambium parts for repair could damage the equipment or void warranty. Contact Cambium for service and repair instructions.

Portions of Cambium equipment may be damaged from exposure to electrostatic discharge. Use precautions to prevent damage.

Security advice

Cambium PTP 820 Networks systems and equipment provide security parameters that can be configured by the operator based on their operating environment. Cambium recommends setting and using these parameters following industry recognized security practices. Security aspects to be considered are protecting the confidentiality, integrity, and availability of information and assets. Assets include the ability to communicate, information about the nature of the communications, and information about the parties involved.

In certain instances, Cambium makes specific recommendations regarding security practices, however the implementation of these recommendations and final responsibility for the security of the system lies with the operator of the system.

Warnings, cautions, and notes

The following describes how warnings and cautions are used in this document and in all documents of the Cambium Networks document set.

Warnings

Warnings precede instructions that contain potentially hazardous situations. Warnings are used to alert the reader to possible hazards that could cause loss of life or physical injury. A warning has the following format:
Caring for the environment

The following information describes national or regional requirements for the disposal of Cambium Networks supplied equipment and for the approved disposal of surplus packaging.

In EU countries

The following information is provided to enable regulatory compliance with the European Union (EU) directives identified and any amendments made to these directives when using Cambium equipment in EU countries.

Disposal of Cambium equipment

Do not dispose of Cambium equipment in landfill sites. For disposal instructions, refer to http://www.cambiumnetworks.com/support

Disposal of surplus packaging

Do not dispose of surplus packaging in landfill sites. In the EU, it is the individual recipient's responsibility to ensure that packaging materials are collected and recycled according to the requirements of EU environmental law.

In non-EU countries

In non-EU countries, dispose of Cambium equipment and all surplus packaging in accordance with national and regional regulations.
Chapter 1: About PTP 820 NMS

Cambium PTP 820 NMS is a comprehensive Network Management System offering centralized operation and maintenance capability for a range of network elements.

Cambium PTP 820 NMS offers full range management of network elements. It can perform configuration, fault, performance and security management. PTP 820 NMS is the user interface to transmission and access products and the key issue for the system is to present management networks in the simplest possible manner. The software has network auto-discovery and uses the configuration data in the network elements to automatically build the managed network. The various elements and their attributes may be accessed using the intuitively graphical presentation of the element and its components. PTP 820 NMS has a continuously updated display of network status and network events are reported from the elements using notifications. An extensive database and context sensitive help facilities enable the user to analyze and report network events.

PTP 820 NMS provides the following network management functionality:

- Fault Management
- Configuration Management
- Performance Monitoring
- Security Management
- Graphical User Interface with Internationalization
- Network Topology using Perspectives and Domains
- Automatic Network Element Discovery
- HW and SW Inventory
- Software Download jobs
- Northbound interface to higher order OSS
- Report Generator

Functionality is maintained during network growth, with solutions covering the entire range of radio networks from a single hop to nationwide multi-technology networks. High availability and reliability is obtained through various redundancy schemes.

PTP 820 NMS functionality

The PTP 820 NMS is scalable both in size and functionality. The NMS Server is the basis for any PTP 820 NMS system, providing basic functionality within the Fault, Configuration, Performance and Security (FCPS) management areas. The NMS Server is by itself an advanced tool for the user to perform operations and monitor network elements for the whole operational network in real time. The flexible client/server architecture gives the operators easy access to all network elements and full control of the system from many different locations.
By selecting among a set of optional features, the PTP 820 NMS system can be enhanced and tailored to each operator’s individual needs and requirements. With all optional features installed, PTP 820 NMS system provides the operator with an advanced and sophisticated network management system that will highly increase the efficiency of operations and maintenance in the network.

For easy integration to external higher-level management systems, a Northbound SNMP interface can be provided.

**Installation Guide**

The PTP 820 NMS Installation Guide can provide you with help about PTP 820 NMS Installation and how to configure the application. For detailed information regarding how to use PTP 820 NMS, including system management information, please see the PTP 820 NMS User Guide.

**More information**

If you cannot find the answer to your question in the installation Guide, contact Cambium support team (see Contacting Cambium Networks for contact details).
Chapter 2: PTP 820 NMS Installation

This chapter describes how to discover, manage, monitor and update NE (Network Elements). It also explains user management, GUI handling and NMS configuration. This chapter consists of the following sections:

- PTP 820 NMS Installation on Windows
- PTP 820 NMS Installation on Solaris
- Post Installation
- Database Installation
- External Documents
PTP 820 NMS Installation on Windows

**Note:** Some of the tasks detailed in the following sub-sections are performed in System Manager. See the *PTP 820 NMS User Guide* for a detailed explanation of System Manager and how to use it.

### Database Installation

PTP 820 NMS requires an Oracle or PostgreSQL database to be installed and available for PTP 820 NMS use. Please refer to PostgreSQL documentation for instructions how to install PostgreSQL. Please refer to Oracle documentation for instructions how to install Oracle.

In general we recommend using an Oracle database rather than a PostgreSQL database because for a given set of hardware conditions, Oracle generally provides considerably better system performance than PostgreSQL.

Please note that PTP 820 NMS System Manager must be installed on the database server. Installation of System Manager is only supported for Windows and Solaris platform. Even though it might be possible to connect PTP 820 NMS to a database on an unsupported platform, some essential features, like backup of database using PTP 820 NMS System Manager, are not supported. We recommend using a system supporting use of PTP 820 NMS System Manager, but if that is not possible, you should set up backup routines for the database manually.

**Language and Date/Time format requirements for Windows**

If you are installing the PTP 820 NMS database on a Windows machine, make sure the Windows language format and date and time formats are as shown in the figure below.
Oracle

For the supported version of Oracle, refer to the *PTP 820 NMS System Requirements* document. When installing Oracle, keep in mind the following:

- Make sure to install Oracle using USA local English.
- If you are installing an Oracle 12c database, it is important to set it up as a single-tenant database configuration and not as a multitenant container database (CDB). That is, the option *Create as Container Database* must be unchecked, as shown below.

**Figure 1** Oracle Create as Container database

![Oracle Create as Container database](image)

Oracle Recommendations

The following Oracle recommendations are suggestions, they are not mandatory.

**Configuring large redo logs**

Oracle best practices recommend having no more than 4 log switches per hour, therefore we recommend configuring larger redo logs (1 Gigabyte each).

**Multiplexing of redo logs and control files**

This is an Oracle-recommended best practice and consists of having at least two copies of a given file on different storage devices, such as different disks or RAID arrays. Unlike RAID mirroring, this process is managed by Oracle and is particularly useful for recovery, such as in the case of a media failure.

**Installing as an Oracle dedicated server**

Oracle can be installed in either dedicated or shared mode. We recommend the dedicated mode, because the Oracle Multithreaded Server (MTS, aka Shared Server) was specifically designed in Oracle 7 when RAM was expensive and there were multiple restrictions related to 32-bit access. In shared mode, a shared server process can service multiple user processes, while in dedicated mode, each user process has a dedicated server process.
Extending the AWR retention period

Oracle recommends that you adjust the AWR retention period to at least a month. You can also extend the period to one business cycle so you can compare data across time frames such as the close of the fiscal quarter.

Separating data files

According to Oracle OFA (Optimal Flexible Architecture), it is recommended to have separate mount points (for separate storage arrays) for binaries and data. Data itself can be split along multiple storage arrays in order to support file multiplexing and distribute I/O operations to avoid bottlenecks.

Creating an additional Oracle custom DBA user

Note: This section applies to Oracle 11.1, Oracle 11.2 and Oracle 12.

You may wish to add a new Oracle custom DBA user, in addition to the default DBA user (system). This user can be used instead of the system user when setting up the PTP 820 NMS database from System Manager.

To create a new Oracle custom DBA user:

1. Create a script that includes the following commands. Call the script, for example, CUSTOM_DBA_USER.sql.

   CREATE USER <user_name> IDENTIFIED BY <password>;
   GRANT SELECT ON sys.user$ TO <user_name>;
   GRANT CREATE SESSION TO <user_name>;
   GRANT SELECT ON sys.v_$session TO <user_name>;
   GRANT SELECT ON sys.v_$transaction TO <user_name>;
   GRANT SELECT ON sys.v_$rollname TO <user_name>;
   GRANT SELECT ON sys.v_$parameter TO <user_name>;
   GRANT datapump_exp_full_database TO <user_name>;
   GRANT datapump_imp_full_database TO <user_name>;
   COMMIT;

2. In a DB IDE (such as SQL Developer, SQuirrel or SQL*Plus), log in as "system as sysdba" or "sys as sysdba".

3. Run the commands in the CUSTOM_DBA_USER.sql file.

   For example, in a Solaris server run:

   # su – oracle
   $ sqlplus / as sysdba
Sqlplus> start <FULL PATH TO SCRIPT>/CUSTOM_DBA_USER.sql

The script will create a user with the username and password you specified, and will grant that user
rights on various tables, parameters and instances. It will also grant the user the rights to use Oracle’s
datapump mechanism for import and export, enabling Backup and Restore of the PTP 820 NMS
database.

**Note:** Instead of creating a new Oracle admin user, you can grant an existing Oracle
system user, the required privileges needed to administrate the PTP 820 NMS Oracle
database. The required privileges are the ones listed in step (1) of this section.

**Oracle post installation**

**Altering system settings for large-scale setups**

To improve overall system performance in large-scale setups, you need to make some changes in
parameter settings after installing Oracle, to make it work optimally with PTP 820 NMS.

Run the following commands on the machine on which you installed the Oracle database:

```sql
alter system set open_cursors=3000 scope=memory;
alter system set optimizer_mode=first_rows;
alter system set processes=600 scope=both sid='*';
```

**PostgreSQL**

For the supported version of PostgreSQL, refer to the *PTP 820 NMS System Requirements* document.

**Migrating from PostgreSQL 9.1.x to PostgreSQL 9.4.x**

Starting from R15A01, PTP 820 NMS works with PostgreSQL 9.4.x. If you had installed PTP 820 NMS
with PostgreSQL 9.1.x, you need to migrate to PostgreSQL 9.4.x, as detailed below.

The migration process detailed below consists of uninstalling the PTP 820 NMS server (whose version is
prior to R15A01), as well as uninstalling the PostgreSQL version 9.1.x; then installing PostgreSQL version
9.4.x and finally installing the new PTP 820 NMS server (version R15A01 or above).

**Note:** Any PTP 820 NMS server upgrade between PTP 820 NMS server versions that
use different Postgres versions, entails uninstalling and re-installing the PTP 820 NMS
server.

1. Perform a back-up of the current PTP 820 NMS active schema using the PostgreSQL 9.1.x version, as
   follows:
   i. Open System Manager,
   ii. Select **Database tasks > Backup User/Schema**,
   iii. Perform a backup of the PTP 820 NMS active schema.
   iv. Copy the backup from its location (by default, this is C:\NgNMS\backup\database), and paste it
      into another folder which you will use for the restore operation.

2. Uninstall the PTP 820 NMS server.
3 Uninstall PostgreSQL version 9.1.x, and delete the folder in which it was installed.

4 Install PostgreSQL version 9.4.x.

5 Perform post-installation as described in PostgreSQL post installation. It is recommended to restart the PostgreSQL 9.4.x server from Services, so that all parameter values are correctly updated.

6 Install PTP 820 NMS version R15A01 or above, taking care to perform the following:
   i In the System Manager’s Initial Setup wizard, create a new schema with the same user name/password as the schema backed up in step (1)(iii).
   ii Take care to uncheck the Start NMS Server checkbox.

7 Perform a user/schema restore with PostgreSQL version 9.4.x, as follows:
   i Open System Manager.
   ii Create a backup of the schema created in step 6.
      iii Navigate to the location of the created backup (C:\NgNMS\backup\database) and note the name of the created backup.
      iv Rename the backup referred to in step (1)(iv), with the name you noted in step (7)(iii).
      v Copy the renamed backup and paste it in the location described in step (7)(iii). That is, overwrite the existing backup.
   vi In the System Manager, go to Database Tasks > Restore User/Schema.
   vii Perform a restore of the backup referred to in step (1)(iv) (which you had renamed in step (7)(iv)).
      Make sure to uncheck the Start NMS Server checkbox.

8 Perform a user/schema upgrade of the restored schema, as follows:
   ◦ If you are still logged into System Manager:
      i Go to Database Tasks > Upgrade User/Schema and upgrade the restored schema.
      ii In the System Manager Dashboard, click Start.
   ◦ If the System Manager session had expired:
      i Log again into System Manager. The Initial Setup wizard should appear.
      ii Follow the instructions for upgrading the restored user/schema.
      iii Following upgrade of the user/schema, the PTP 820 NMS server should start.

PostgreSQL post installation

After installation of PostgreSQL you will have to make some changes in parameter settings to make it work optimally with PTP 820 NMS:

1 Start the pgAdmin tool. You will find it in Start > All programs > PostgreSQL 9.4 > pgAdmin III.
2 Connect to your PostgreSQL database server.
3 Expand the following in the left window: PostgreSQL Database Server > Databases > Postgres.

4 Choose Tools > Server Configuration > postgresql.conf.

5 Locate the setting named max_prepared_transactions, double-click on it and change its value to 300 (or to a value that is equal to or higher than the max_connections setting listed in the table below). Also select the Enabled check box.

6 Click OK.
The table below contains required minimum values for running PTP 820 NMS with PostgreSQL.

### Table 1 Required minimum values for running PTP 820 NMS with PostgreSQL

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Required in large setups</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>max_prepared_transactions</td>
<td>300</td>
<td>600</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>In a PTP 820 NMS Server High Availability setup, the required number is 600</td>
<td>In a PTP 820 NMS Server High Availability setup, the required number is 1100</td>
<td></td>
</tr>
<tr>
<td>max_connections</td>
<td>250</td>
<td>500</td>
<td>100</td>
</tr>
<tr>
<td></td>
<td>In a PTP 820 NMS Server High Availability setup, the required number is 500,</td>
<td>In a PTP 820 NMS Server High Availability setup, the required number is 1000</td>
<td></td>
</tr>
<tr>
<td>maintenance_work_mem</td>
<td>32 MB</td>
<td>1023 MB</td>
<td>64 MB</td>
</tr>
<tr>
<td>shared_buffers</td>
<td>64 MB</td>
<td>256 MB</td>
<td>128 MB</td>
</tr>
<tr>
<td>temp_buffers</td>
<td>16 MB</td>
<td>16 MB</td>
<td>8 MB</td>
</tr>
<tr>
<td>effective_cache_size</td>
<td>128 MB (Postgres default)</td>
<td>1024 MB</td>
<td>4 GB (Postgres default)</td>
</tr>
</tbody>
</table>
Chapter 2: PTP 820 NMS Installation  
Database Installation

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Required in large setups</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Windows</td>
<td>Solaris</td>
<td></td>
</tr>
<tr>
<td>work_mem</td>
<td>4 MB</td>
<td>8 MB</td>
<td>4 MB</td>
</tr>
<tr>
<td>checkpoint_segments</td>
<td>12</td>
<td>12</td>
<td>32</td>
</tr>
<tr>
<td>checkpoint_completion_target</td>
<td>Use default</td>
<td>0.7</td>
<td>0.7</td>
</tr>
<tr>
<td>wal_buffers</td>
<td>Use default</td>
<td>16 MB</td>
<td>16 MB</td>
</tr>
</tbody>
</table>

7 In the pgAdmin tool choose **File > Save**.

8 If you plan to install the PTP 820 NMS server on a different server than the PostgreSQL server, you have to enable access in the host based authentication configuration.

9 Choose **Tools > Server configuration > pg_hba.conf**.

10 Add an entry with IP-address and subnet mask of the client that shall be allowed access to the database server.

- In a **PTP 820 NMS Server High Availability** setup, add the IP address of the Primary server and the IP address of the Secondary server.

- If this database is participating in a **PTP 820 NMS Database High Availability** setup, add the IP address of the machine on which this database is installed, the IP address of the mate database machine, as well as the IP addresses of the Primary and Secondary PTP 820 NMS servers.

**Figure 4** PTP 820 NMS Server High Availability Primary IP address

More details on this are given in the PostgreSQL online help.

11 In the pgAdmin tool choose **File > Save**.

12 To make the change take effect the PostgreSQL server will have to reload the configuration files. From the Windows Start menu choose **All Programs > PostgreSQL 9.4 > Reload Configuration**.

13 In the displayed command window, click **Return**.

**Note:** If the configured changes do not take effect modify the `<Postgres installation dir>/data/pg_hba.conf` manually.
PTP 820 NMS Windows Installation

NMS Server Pre-installation for Windows

Prepare Database

PTP 820 NMS Server requires a database to work. Make sure that a database server is installed and reachable from the computer on which PTP 820 NMS Server must be installed. The database server can be installed on the same computer as the PTP 820 NMS Server – refer to the PTP 820 NMS System Requirements document for guidance. However, it does not need to be installed on the same computer.

If the database server is running on a different computer than the NMS Server, the **Firewall settings** on the database server may have to be modified (i.e. open the port used for communication with the database server).

Oracle and PostgreSQL database servers are supported - see the PTP 820 NMS System Requirements document for information about supported database editions.

**Note**
The pre-installation steps are not required for PTP 820 NMS Client or the Northbound SNMP Agent installations.

Java Installation

1. We recommend removing all JRE installations from the computer on which you will install PTP 820 NMS (client and/or server)
2. Download both the 32 and 64 JRE versions from the official Oracle site: https://www.oracle.com/downloads/index.html.
3. **Note**: Take care to download the recommended JRE version which is 1.7.0_80, except in the case of Windows 2012 where you should download version 1.7.0_45.
4. Install both the 32 and 64 JRE versions.
5. Configure two system environment variables to point to the two JRE versions. For example:

   ```
   Variable name: NMS_JAVA_HOME_32
   Variable value: C:\Program Files (x86)\Java\jre7
   
   Variable name: NMS_JAVA_HOME_64
   Variable value: C:\Program Files\Java\jre7
   ```
6. Restart the computer.
PTP 820 NMS Installation for Windows

This guide requires that the steps for NMS Server Pre-installation for Windows already have been completed.

PTP 820 NMS Install Sets

NMS allows you to install any of the following install units:

<table>
<thead>
<tr>
<th>Install Unit</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client</td>
<td>PTP 820 NMS Client. Can be installed on a separate machine. Also available for Solaris platform, see PTP 820 NMS Client installation for Sun Solaris for details.</td>
</tr>
<tr>
<td>Server</td>
<td>PTP 820 NMS Server.</td>
</tr>
<tr>
<td>System Manager</td>
<td>Configuration and maintenance tool for PTP 820 NMS Server. System Manager must be installed on both the PTP 820 NMS Server and the database server.</td>
</tr>
<tr>
<td>SNMP Agent</td>
<td>Northbound interface to higher-order network management systems</td>
</tr>
</tbody>
</table>
All install sets:

**Table 3** MMS Install Sets

<table>
<thead>
<tr>
<th>Install Set</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client</td>
<td>PTP 820 NMS Client only.</td>
</tr>
<tr>
<td>Server</td>
<td>PTP 820 NMS Client, PTP 820 NMS Server, SNMP Agent, and System Manager.</td>
</tr>
<tr>
<td>System Manager</td>
<td>System Manager only. Intended for stand-alone database server installation.</td>
</tr>
<tr>
<td>Custom</td>
<td>Pick one or more of all available install units.</td>
</tr>
</tbody>
</table>

**Install Modes**

There are three modes of installation:
- New Installation
- Upgrade Installation
- Maintenance Installation

The PTP 820 NMS installer looks for existing PTP 820 NMS installations on your installation server in order to determine correct install mode.

**New installation for Windows**

1. If no existing PTP 820 NMS installation is detected on the computer, the installer will run in New Installation mode.
2. You may cancel the installation at any step until the wizard starts installing the files.
3. Run the Setup.exe file to launch the PTP 820 NMS Installer home page.
5. Click **Run** to continue installation. An Internet Explorer Security Warning pop-up window appears.
1. Click **Run** to continue installation. An Internet Explorer Security Warning pop-up window appears.

2. Click **Run** to continue installation.
3. The Installer prepares to start.

![Installation Wizard](image)

4. Proceed by following the Installation wizard as follows:
5. Installation wizard in New installation mode.
6. The **Introduction** step displays some general information about the installation process.

**Figure 7** PTP 820 NMS Installation
7. Click Next to continue the wizard.
8. Read the license agreement.

**Figure 8** License Agreement
9. If you accept the agreement, select the **Accept** option and then click Next to continue.

10. **Choose Install Set** step. Note that the PTP 820 NMS Server install sets include Server, System Manager, Client and Northbound SNMP Agent.

**Figure 9** Choose Install Set
11. Click **Next** to continue.

12. **Choose Install Set** step - **Custom**. This step is only displayed if the "custom" install set is selected in the previous step.

13. In this step you can select each component individually. See the **Description** field for information about the selected component.

**Figure 10** PTP 820 NMS Installation
14. Click **Next** to continue.

15. **Choose Install Folder** step.

16. In this step you can choose where on the file system to install the software.

**Figure 11** Choose Install folder
17. Click **Next** to continue.

18. **Choose Shortcut Folder** step.

   In this step you can choose where to place product icons/shortcuts. Note that there is an option for creating icons for all Users.

**Figure 12 Choose Shortcut Folder**

![Choose Shortcut Folder](image)
19. Click **Next** to continue.
20. **Pre-Installation Summary** step.
  This step gives an overview of the current selections.

**Figure 13** Pre-Installation Summary
21. **Installing** step.

Watch the product features being presented during the installation progress.

**Figure 14** Installing PTP 820 NMS
22. **Install Complete** step.

If there were any problems encountered during the installation, see the installation log file located in the installation destination folder for details.

**Figure 15** Install Complete
23. Click **Done** to finish the wizard. The installation wizard configures the system when completing the wizard.

24. If included in the installation set, **System Manager** can be opened at the end of installation.

**Figure 16** Start System Manager Session

25. Click **Yes** to open System Manager, and complete configuration of PTP 820 NMS, including importing a license, connecting PTP 820 NMS to a database, scheduling database backup and setup mail parameters.

**Note:** If PTP 820 NMS Server is installed, the server will be installed as an automatic Windows Service, with its own Server monitor in the systray. The PTP 820 NMS Server monitor starts when installation is completed, and you are prompted whether to start the PTP 820 NMS Server. If you don't want the PTP 820 NMS Server to start automatically upon computer reboot, you can set the mode of the PTP 820 NMS Service to manual in the Services applet in the Control Panel.

Proceed with the PTP 820 NMS Server **Post installation steps**.
Upgrade installation

Notes:

- Upgrade is not supported for PTP 820 NMS servers in a server high availability setup. When upgrading to PTP 820 NMS version R15A00 and above, follow the steps in Java Installation before starting the upgrade.
- Prior to upgrading an installation, run the Analyze User/Schema wizard from the Administration->Database Analysis view in System Manager. If the analysis report lists any problems, refer the problems to the Customer Support team.

- If the installer detects an older version of PTP 820 NMS installed on the computer, the installer will run in Upgrade mode. In this mode, you will be able to upgrade the existing components and to reselect which components to be installed on the computer. The existing installation will be uninstalled and replaced with the components selected in this maintenance installation. Note that existing components not selected will be uninstalled.
- PTP 820 NMS System Manager can be launched after the PTP 820 NMS software installation and gives options to upgrade or reset the PTP 820 NMS database.

Note

Action permissions for new functionality are default disabled for all user groups; these must be specifically granted for user groups needing access.

The PTP820NMS_environment.cmd file will be generated however the database administration user and password will be left empty.

Most of the installation steps are identical to the New Installation mode:

- **Introduction** step - informs that a previous version of PTP 820 NMS is detected and displays some information about the detected installation.
- **License Agreement** step is omitted in upgrade installations.
- **Choose Install Items** step - this step initially displays the components detected in the existing PTP 820 NMS installation. In this step, you can select which components to be installed on the computer. Note that if you deselect existing components, those will be uninstalled.
- **Choose Install Folder** and **Choose Shortcut Folder** steps - omitted in upgrade installations. The installer will use the folders detected from the previous installation.
- **Pre Install** Summary step - gives an overview of the current selections.
- **Installing** step - watch the product features being presented during the installation progress.
- **Installation Summary** - same as in new installations.

Proceed with the **PTP 820 NMS Server post installation**.
Maintenance installation

If the installer detects an existing PTP 820 NMS installation with the same version, the installer will run in Maintenance mode. In this mode you will be able to reselect which components to be installed on the computer. The existing installation will be uninstalled and replaced with the components selected in this maintenance installation. Existing components not selected will be uninstalled.

PTP 820 NMS System Manager can be launched after the PTP 820 NMS software installation and gives the option to reinitialize the NMS database.

Most of the installation steps are identical to the New Installation mode:

- **Introduction step** – informs that an existing installation is detected, and displays some information about the detected installation.
- **Choose Install Items step** – this step initially displays the components detected in the existing PTP 820 NMS installation. In this step you can select which components to be installed on the computer. Note that if you deselect existing components, those will be uninstalled.
- **Installation Summary** - same as in new installations.
- **Installing step** – the existing PTP 820 NMS installation will be uninstalled before this installer installs the selected components. (This step requires no user interaction)
- **Pre-Install Summary step** – this step gives an overview of the current selections.
- **Installing step** – watch the product features being presented during the installation progress.
- **Install Complete step** – this step is the same as in new installations.

Proceed with the **PTP 820 NMS Server post installation**.

System Manager Installation on Database Server

The System Manager tool is installed together with the PTP 820 NMS Server and provides the NMS operators an easier and more flexible way to deal with some PTP 820 NMS administrative tasks:

- Set up NMS database connection
- Upgrade old NMS database to a new version
- Backup/restore database (requires System Manager on database server)
- Schedule database backup and database maintenance tasks
- Configure email notification
- Start and stop of NMS Server

As database backup and restore operations MUST be run on the actual database server, you must install System Manager as a standalone application on your database server if you want System Manager to handle database backup and restore for you.
A database export will then work like this:

1. User logs on to System Manager on the NMS server and requests a database backup. (Or a periodic database backup job has just started.)

2. A request is sent to System Manager on the database server that runs a database backup job and stores the export file in the default folder C:\PTP 820 NMS\Backup\Database on the database server.

3. System Manager on the PTP 820 NMS server then copies the newly created database export file from the database server and places it in the location specified in the Database view available from the System Manager Settings menu. The default location is C:\PTP 820 NMS\backup\database on the NMS server.

---

**Note**

If System Manager is not installed on the database server, the database backup and restore feature in System Manager is not available.

**Note**

If the local computer has more than one network card, in order to let know to System Manager which ip can be used for remote connection with secondary System Manager please define own ip in C:\Program Files (x86)\PTP820NMS\SystemManager\sysman.properties

**Note**

In the case of a backup done before an upgrade operation (started either from the Initial Setup Wizard or from the "Upgrade User/Schema" menu), the backup is kept only on the database server.
Installation

1. If no existing System Manager installation is detected on the database server, the installer will run in New Installation mode.
2. You may cancel the installation at any step until the wizard starts installing the files.
3. Run the Setup.exe file to launch the PTP 820 NMS Installer home page.
5. Click Run to continue installation. An Internet Explorer Security Warning pop-up window appears.

Click **Install PTP 820 NMS** to initiate NMS installation.

Internet Explorer needs to know that you trust the installer:

Proceed to install PTP 820 NMS by running the PTP 820 NMS Installation wizard as follows:
The Introduction step displays some general information about the installation process.
Figure 18 Installation wizard - Introduction

Click **Next** to continue the wizard.

Read the license agreement.

Figure 19 Installation wizard – License agreement

If you accept the agreement, select the Accept option and then click **Next** to continue.
Choose Install Set step. Select PTP 820 NMS Database Server only. This is in fact System Manager in standalone mode.

**Figure 20** Installation wizard – Choose install set

Click **Next** to continue.
Choose Install Folder step.
In this step you can choose where on the file system to install the software.

**Figure 21** Installation wizard – Choose shortcut folder

Click **Next** to continue.

Choose Shortcut Folder step.
In this step you can choose where to place product icons/shortcuts. Note that there is an option for creating icons for all Users.
Figure 22 Installation wizard – Choose shortcut folder

Click **Next** to continue.

Pre Installation Summary step.

This step gives an overview of the current selections.

Figure 23 Installation wizard – Choose shortcut folder

Click **Install** to continue the wizard.

Installing step
Watch the product features being presented during the installation progress.

**Figure 24** Installation wizard - Installing PTP 820 NMS

Install Complete step.

If there were any problems encountered during the installation, see the installation log file located in the installation destination folder for details.
**Figure 25** Installation wizard – Install complete

Click **Done** to finish the wizard.
Configuration

If you open System Manager on the database server, the following information is shown:

Figure 26 NMS System Manager

All configuration should in general take place using the System Manager that is installed on the PTP 820 NMS server, and not on the Database Server.

However, please note that database backups will by default be saved in a folder on the same drive as the database installation folder. As the database backups occupy too large amounts of space on the storage drive, it might be helpful to change the database folder to a location on a different drive. On a system with standalone Database Server, this must be done manually.

How to change folder for backups on a standalone Database Server

If you want to change the folder for backups on a standalone Database Server, do the following:

1. On the database server, go to the folder:
   <PTP 820 NMS_installation>/SystemManager/conf/system/
2. Open the file:
   string@DatabaseBackupPath.xml
3. Change the path to another existing location and save the file
**Upgrade PTP 820 NMS Windows installation**

**Before upgrading in Windows**

- Prior to upgrading an installation, run the **Analyze User/Schema** wizard from the **Administration->Database Analysis** view in System Manager (as described in the *PTP 820 NMS User Guide*). If the analysis report lists any problems, refer the problems to the Cambium Networks Customer Support team.

- All PTP 820 NMS services must be stopped before installing the new version. This includes the PTP 820 NMS Server, the PTP 820 NMS System Manager, and the PTP 820 NMS SNMP Agent. In rare cases in which you do not manage to stop one of these services, you must reboot the machine and then verify these services are stopped.

**Performing an upgrade in Windows**

For the Windows platform, version R18A00 of the Application installer supports only new installations due to the Java version change. Version R18A00 does not support Upgrade or Maintenance. This means that you must uninstall the current version before installing a new version. Uninstalling the version will not affect the information in the database, which will be maintained.

Perform the following:

1. Backup the contents of PTP 820 NMS\System Manager\conf and PTP 820 NMS\System Manager\log from the old PTP 820 NMS installation.
2. Uninstall the old PTP 820 NMS version as described in *Uninstall PTP 820 NMS for Windows*.
3. Uninstall the current Java installation and install Java again, as described in *Java Installation*.
4. Install the new PTP 820 NMS version as described in *New Windows installation*. However, before starting System Manager, replace the contents of PTP 820 NMS\System Manager\conf and PTP 820 NMS\System Manager\log in the new installation, with the backups you created in Step 1.
5. Edit the PATH variable to remove the value C:\Program Files(x86)\PTP 820 NMS\CLI_Reports, and instead enter the value: C:\Program Files\PTP 820 NMS\CLI_Reports.
6. In Windows Services, restart the System Manager service called *NG NMS System Manager*.

Open System Manager and perform database upgrade as guided by the wizard (see the *PTP 820 NMS User Guide* for a detailed explanation).

**Note**

Action permissions for new functionality are by default disabled for all user groups; these must be specifically granted for user groups needing access.

The PTP 820 NMS_environment.cmd file will be generated, however the database administration user and password will be left empty.
Uninstall PTP 820 NMS for Windows

To uninstall PTP 820 NMS, run Uninstall PTP 820 NMS from the PTP 820 NMS program folder. You can also locate PTP 820 NMS in the Add or Remove Programs folder in the Control Panel and click the Change/Remove button.

Run the PTP 820 NMS Uninstaller wizard:

**Figure 27** PTP 820 NMS Uninstaller wizard

Click **Uninstall** to continue the wizard. A confirmation dialog appears:

**Figure 28** PTP 820 NMS Uninstaller confirmation dialog

Click **Yes** to confirm PTP 820 NMS removal.

NMS is now uninstalled.
Click **Done** to exit the PTP 820 NMS Uninstaller wizard.
PTP 820 NMS Installation on Solaris

PTP 820 NMS Pre-installation for Solaris

Server host name

The server host name should not contain ‘_’ (underscore).

Region and Language requirements

The language of the operating system and database on which PTP 820 NMS is installed must be English (United States).

Prepare Database

PTP 820 NMS Server requires a database to work. Make sure that a database server is installed and reachable from the computer on which you want to install PTP 820 NMS Server.

If the database server is running on a different computer other than the PTP 820 NMS Server, the firewall settings on the database server may have to be modified (i.e. open the port used for communication with the database server).

Supported databases are Oracle and PostgreSQL. See the PTP 820 NMS System Requirements document for information about supported database editions.

Note

For an Oracle database, we recommend installing a stand-alone database on Windows Server 2008 64bit platform instead, using the procedure System Manager Installation on Database Server.

Java installation For Solaris

JRE 1.8.0_201 can be found currently on the following Oracle links:
jre-8u201-solaris-sparcv9.tar.gz or jre-8u201-solaris-x64.tar.gz for Solaris

Note
The Oracle links for downloading JRE 1.8.0_201 may change.

After the JRE 1.7.0.80 is installed, do the following steps:

1. Open a command prompt (cmd).
2. Verify that the installed JRE is in PATH by typing `java -version`
3. If the `java` command is not recognized, you must add the `bin` directory under the JRE installation directory to the PATH.

4. If the command is recognized, you shall see the version of the installed JRE.

5. If the version is not 1.8, make sure you installed JRE version 1.8.0_201, and enter the following in the command prompt:

   ```
   cd /usr
   rm java
   ln -s /usr/jre/jre1.8.0_201java
   ```

Register PTP 820 NMS Server at DNS

To establish connection between PTP 820 NMS Client and PTP 820 NMS Server, it is required that the PTP 820 NMS Server host is registered in DNS.

Prepare Apache Ant

Ensure that Apache Ant of version at least 1.8.1 is installed on the Solaris machine.

If not installed, do the following:

1. Install ant (unpack the archive from folder `/ant` on installation media) on a file system with enough space.

2. Create a symbolic link:

   ```
   ln -s <Ant install folder>/apache-ant-1.8.1/bin/ant /usr/bin/ant
   ```

PTP 820 NMS Server Installation for Solaris

The following section guides you through PTP 820 NMS Server, System Manager and SNMP Agent installation on Solaris platform.

---

**Note**

This section requires that the steps for Pre Installation for Solaris already have been completed.

---

PTP 820 NMS Server is supported on Sun Solaris 11 with a non-SPARC x86 platform, as well as on SUN Solaris 10 operating system on a SPARC platform.

PTP 820 NMS Client must be installed on a Windows platform, see PTP 820 NMS installation for Windows for details.

**PTP 820 NMS Install Sets**

PTP 820 NMS allows you to install any of the following install units:

<table>
<thead>
<tr>
<th>Install Unit</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Table 4</strong> NMS install sets</td>
<td>PTP 820 NMS allows you to install any of the following install units:</td>
</tr>
</tbody>
</table>
Chapter 2: PTP 820 NMS Installation

PTP 820 NMS Installation on Solaris

Server
PTP 820 NMS Server.

System Manager
Configuration and maintenance tool for PTP 820 NMS Server. System Manager must be installed on both the PTP 820 NMS Server and the database server.

SNMP Agent
Northbound interface to higher-order network management systems

PolyView

Topology Import
Enables exporting discovered elements and subnetworks from PolyView into a file and then importing them, while preserving their hierarchy, into PTP 820 NMS as managed elements in administrative domains

All install sets:

Table 5  NMS all install sets

<table>
<thead>
<tr>
<th>Install Set</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server</td>
<td>PTP 820 NMS Server, SNMP Agent, System Manager and PolyView Topology Import</td>
</tr>
<tr>
<td>System Manager</td>
<td>System Manager only, intended for stand-alone database server installation.</td>
</tr>
<tr>
<td>Custom</td>
<td>Pick one or more of all available install units</td>
</tr>
</tbody>
</table>

Install Modes

For the Solaris platform, this version of the installer supports only new installations. (No Upgrade/Maintenance). This means that you must uninstall the current version before installation.

Please note that the installation of PTP 820 NMS on Solaris is less automated compared to Windows installer, and some steps need to be done manually.

New Installation

Execute the installer as root.

1. Unpack the PTP 820 NMS installer PTP 820 NMS-sol_*****.zip to a temporary folder and do the following:

```bash
cd <temporary folder>/Disk1/InstData/NoVM/
sh Setup.bin
```

2. When choosing installation directory in the installer, ensure that the folder has enough free space, and is within the boot partition. This is to make sure that the services will start automatically after a reboot of the machine. Ensure also that the installation path string does not contain any spaces.

3. Complete the installation wizard. The steps in the installation for Solaris are basically the same as in New Windows Installation, except that Client is not an option in Solaris version.

If the installer reports that the installation succeeded with some errors, you can search for ERROR in <install-dir>/PTP 820 NMS_InstallLog.log.

If the only errors relate to Modify Text File and Create Link, then everything is OK.
Register PTP 820 NMS Services

When the installation wizard is completed, register services by performing the following:

1. Ensure that Apache Ant is installed as described in Prepare Apache Ant. Otherwise, install it now.
2. cd to <install-dir> (by default, this is /usr/PTP 820 NMS/).

Check Service Status

If you want to check the status of the PTP 820 NMS services:

```
svcs ngSysMgr ngNMSService ngNIFService
```

If you installed PTP 820 NMS Server (ngNMSService), System Manager (ngSysMgr) and SNMP Agent (ngNIFService), the result should be something like this:

<table>
<thead>
<tr>
<th>STATE</th>
<th>STIME</th>
<th>FMRI</th>
</tr>
</thead>
<tbody>
<tr>
<td>disabled</td>
<td>10:48:42</td>
<td>svc:/application/ngNMSService:default</td>
</tr>
<tr>
<td>disabled</td>
<td>10:48:44</td>
<td>svc:/application/ngNIFService:default</td>
</tr>
<tr>
<td>online</td>
<td>10:48:51</td>
<td>svc:/application/ngSysMgr:default</td>
</tr>
</tbody>
</table>

Start a System Manager Web Browser Session

In a web browser navigate to:

http://<PTP 820 NMS server address>:18080/SystemManager/main?dialog=setup

where `<PTP 820 NMS server address>` = address of the server where System Manager is running.

The System Manager tool contains database related tasks and also general PTP 820 NMS maintenance tasks intended to ease PTP 820 NMS configuration. After closing the PTP 820 NMS Installer, you need to launch System Manager and complete configuration of PTP 820 NMS, including importing a license (see PTP 820 NMS license), connecting PTP 820 NMS to a database, scheduling database backup and setting up email parameters.

Log in using System Manager administrator user. System Manager will if needed automatically launch the PTP 820 NMS Initial Setup wizard that will help you through the necessary setup pages (see the PTP 820 NMS User Guide for details).

The initial authentication credentials for the System Manager administrator are:

User name: root
Password: pw

Note

It is strongly recommended to change the password of the root account as soon as possible to prevent unauthorized access. To change the password, open the System Manager Settings view.

See the PTP 820 NMS User Guide for more information about System Manager and how to use it.

After the server is started, the PTP 820 NMS client can be accessed. For more details see PTP 820 NMS GUI Client. For details regarding specific post-installation configurations, see the PTP 820 NMS Server Post installation steps.
Upgrade PTP 820 NMS Solaris installation

Performing an upgrade in Solaris
For the Solaris platform, this version of the Application installer supports only new installations, no Upgrade or Maintenance. This means that you must uninstall the current version before installing a new version. Uninstalling the version will not affect the information in the database, which will be maintained. Perform the following:

1. Uninstall the old PTP 820 NMS version as described in Uninstall PTP 820 NMS for Solaris.
2. Install the required Java version, as described in Java installation for Solaris.
3. Install the new PTP 820 NMS version as described in PTP 820 NMS Server Installation for Solaris.

If the server works with IPv4 addresses, perform the adjustment described in Working with IPv4. After installing the new version, connect as instructed to System Manager, perform initial setup, and take care to select the existing database user/schema in the User/Schema Parameters page of the Initial Setup wizard, and to specify the existing database and database credentials. This will automatically upgrade the existing database, after which the server can be started. Refer to the PTP 820 NMS User Guide for a full description of System Manager and how to use it.

Uninstall PTP 820 NMS for Solaris

Please note that the uninstallation of PTP 820 NMS on Solaris less automated compared to the Windows version.
Run uninstaller:
```
sh <install-dir>/Uninstall\ PTP 820 NMS Uninstall_PTP820NMS
```
Remove files:
```
rm -r <install-dir>
rm -r /var/svc/manifest/application/ptp820nms/
```

PTP 820 NMS Server Post Installation

This section describes post installation steps for a PTP 820 NMS Server installation.

Note
This section requires that the steps for PTP 820 NMS Installation on Windows or PTP 820 NMS Installation on Solaris already have been completed.

Note that for a new and upgrade installation, PTP 820 NMS is not ready to run until System Manager’s PTP 820 NMS Initial Setup wizard is completed.
System Manager Installation on Database Server

The System Manager tool is installed together with the PTP 820 NMS Server and provides the PTP 820 NMS operators an easier and more flexible way to deal with some PTP 820 NMS administrative tasks:

- Set up PTP 820 NMS database connection
- Upgrade old PTP 820 NMS database to a new version
- Backup/restore database (requires System Manager on database server)
- Schedule database backup and database maintenance tasks
- Configure email notification
- Start and stop of PTP 820 NMS Server

As database backup and restore operations MUST be run on the actual database server, you have to install System Manager as a standalone application on your database server if you want System Manager to handle database backup and restore for you.

A database export will then work like this:

1. User logs on to System Manager on the PTP 820 NMS server and requests a database backup. (Or a periodic database backup job has just started.)
2. A request is sent to System Manager on the database server that runs a database backup job and stores the export file in the default folder C:\NgNMS\backup\database on the database server.
3. System Manager on the PTP 820 NMS server then copies the newly created database export file from the database server and places it in the location specified in the Database view available from the System Manager Settings menu. The default location is C:\NgNMS\backup\database on the PTP 820 NMS server.

Note: If System Manager is not installed on the database server, the database backup and restore feature in System Manager is not available.
If the local computer has more than one network card, in order to let know to System Manager which IP can be used for remote connection with secondary System Manager please define own IP in C:\Program Files\PTP 820 NMS\SystemManager\sysman.properties.

In the case of a backup done before an upgrade operation (started either from the Initial Setup Wizard or from the "Upgrade User/Schema" menu), the backup is kept only on the database server.

### Installation

If no existing System Manager installation is detected on the database server, the installer will run in New Installation mode.

You may cancel the installation at any step until the wizard starts installing the files.

Press the **Install PTP 820 NMS** button to initiate System Manager installation.

Internet Explorer needs to be told to run the installer:

Click **Run** to continue installation.
Internet Explorer needs to know that you trust the installer:

![Internet Explorer Security Warning]

Click **Run** to continue installation.

The Installer is preparing to start:

![InstallAnywhere]

Proceed to install PTP 820 NMS by running the **Installation** wizard as follows:
The **Introduction** step displays some general information about the installation process.

Click **Next** to continue the wizard.

Read the license agreement.

If you accept the agreement, select the Accept option and then click **Next** to continue.
Choose Install Set step. Select **PTP 820 NMS Database Server** only. This is in fact System Manager in standalone mode.

**Figure 30** System Manager in standalone mode

Choose Install Folder step.

In this step you can choose where on the file system to install the software.
Click **Next** to continue.

**Choose Shortcut Folder** step.

In this step you can choose where to place product icons/shortcuts. Note that there is an option for creating icons for all Users.
Click **Next** to continue.

**Pre Installation Summary** step.

This step gives an overview of the current selections.

**Figure 31** Pre-installation Summary

Click **Install** to continue the wizard.

**Installing** step

Watch the product features being presented during the installation progress.
Install Complete step.

If there were any problems encountered during the installation, see the installation log file located in the installation destination folder for details.

Click Done to finish the wizard.
Configuration

If you open **System Manager** on the database server the following information is shown:

![System Manager](image)

**Figure 32 System Manager**

All configuration should in general take place using the System Manager that is installed on the PTP 820 NMS server, and not on the Database Server.

However, please note that database backups will by default be saved in a folder on the same drive as the database installation folder. As the database backups occupy too large amounts of space on the storage drive, it might be helpful to change the database folder to a location on a different drive. On a system with standalone Database Server, this must be done manually.

**How to change folder for database backups on a standalone Database Server**

If you want to change the folder for backups on a standalone Database Server, do the following:

1. On the database server, go to the folder:
   ```
   <PTP 820 NMS_installation>/SystemManager/conf/system/
   ```

2. Open the file:
   ```
   string@DatabaseBackupPath.xml
   ```
3 Change the path to another existing location and save the file

**Firewall settings**
Configure the following port exceptions in the firewalls according to your needs.

Towards the PTP 820 NMS server
The following is configured on the inbound firewall of the machine hosting the PTP 820 NMS server.

<table>
<thead>
<tr>
<th>Port</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TCP 8080</td>
<td>Master port for several types of communication</td>
</tr>
<tr>
<td>TCP 61616</td>
<td>Used by PTP 820 NMS client to connect to an enterprise messaging queue that runs within PTP 820 NMS, used to push events to the client about changes in services.</td>
</tr>
</tbody>
</table>
| UDP 162 (or as configured by the user in System Manager) | SNMP Trap Port  
Default port is 162, but can be set to a different port in the Snmp Trap Port Number field in System Manager’s NMS Server view |
| UDP 161    | SNMP get/set when SNMP Agent is used                                         |

Towards the NE
The following is configured on the outbound firewall of the machine hosting the PTP 820 NMS server.

<table>
<thead>
<tr>
<th>Port</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TCP 80</td>
<td>HTTP - Hypertext Transfer Protocol</td>
</tr>
<tr>
<td>TCP 443</td>
<td>HTTPS - Hypertext Transfer Protocol Secure</td>
</tr>
<tr>
<td>UDP 161</td>
<td>SNMP get/set</td>
</tr>
</tbody>
</table>

Towards the PTP 820 NMS server if FTP is used
The following is configured on the inbound firewall of the machine hosting the FTP server.

<table>
<thead>
<tr>
<th>Port</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TCP 20</td>
<td>FTP - File Transfer Protocol [default data]</td>
</tr>
<tr>
<td>TCP 21</td>
<td>FTP - File Transfer Protocol [Control]</td>
</tr>
</tbody>
</table>
Towards the PTP 820 NMS server if SFTP is used

The following is configured on the inbound firewall of the machine hosting the SFTP server.

Table 9 Towards the PTP 820 NMS server if SFTP is used

<table>
<thead>
<tr>
<th>Port</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TCP 20</td>
<td>SFTP – Secure File Transfer Protocol [default data]</td>
</tr>
<tr>
<td>TCP 22</td>
<td>SFTP – Secure File Transfer Protocol [Control]</td>
</tr>
</tbody>
</table>

Note: For SFTP usage it is required to use SSH software, such as OpenSSH, that supports the ability to change the root directory.

Towards the PTP 820 NMS database machine

The following is configured on the inbound firewall of the machine hosting the PTP 820 NMS database.

Table 10 Towards the PTP 820 NMS database machine

<table>
<thead>
<tr>
<th>Port</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TCP 1521</td>
<td>Oracle Database server</td>
</tr>
<tr>
<td>TCP 5432</td>
<td>Postgres SQL Database server</td>
</tr>
</tbody>
</table>

Towards the System Manager installation

The following is configured on the inbound firewall of the machine hosting the System Manager.

Table 11 Towards the System Manager installation

<table>
<thead>
<tr>
<th>Port</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TCP 1521</td>
<td>Oracle Database server</td>
</tr>
<tr>
<td>TCP 5432</td>
<td>Postgres SQL Database server</td>
</tr>
<tr>
<td>TCP 18005</td>
<td>Shutdown port</td>
</tr>
<tr>
<td>TCP 18010</td>
<td>AJP connector port</td>
</tr>
<tr>
<td>TCP 18080</td>
<td>Connector port</td>
</tr>
<tr>
<td>TCP 18443</td>
<td>Redirect port</td>
</tr>
</tbody>
</table>

For Windows Firewall, these ports can be opened as follows:

1. Open the Windows Firewall in the Windows Control Panel
2. In the General tab, make sure that On (recommended) is selected and that Don’t allow exceptions is not checked.
3. In the Exceptions tab, click Add Port. Repeat for all ports to allow.
   i. Type the name, e.g. “nms_server_port”.
   ii. Type the port number, e.g. “8080”.

For SFTP usage it is required to use SSH software, such as OpenSSH, that supports the ability to change the root directory.
iii Make sure that TCP is selected.

iv If you want to limit the IP addresses that are allowed to connect using this port, click the Change scope button:
   ◦ Select Custom list and specify the IP-addresses of all GUI Client computers, or
   ◦ Select My network (subnet) only to only allow GUI Clients within your local subnet.
   ◦ Click OK.

4 Click OK.

5 In the Advanced tab, make sure that the network connection your computer is using is enabled (checked) in the Network Connection Settings list.

For other firewalls, different procedures may be required.

## Reserving ports

Reserving ports on the machine hosting the PTP 820 NMS server

The following ports need to be left empty on the machine hosting the PTP 820 NMS server so that the application can bind to them.

<table>
<thead>
<tr>
<th>Port</th>
<th>Description</th>
</tr>
</thead>
</table>
| UDP 162 (or as configured by the user in System Manager) | SNMP Trap Port
   Default port is 162, but can be set to a different port in the Snmp Trap Port Number field in System Manager’s NMS Server view. |
| UDP 1621      | SNMPv1 and SNMPv2c internal trap port. In use on the server machine when either SNMPv1 or SNMPv2c traps are received from the device on the SNMP trap port (default: 162). This port does not need to be opened on the firewall. |
| UDP 1622      | SNMPv3 internal trap port, in use on the server machine when SNMPv3 traps are received from the device on the SNMP trap port (default: 162). This port does not need to be opened on the firewall. |
| TCP 4712      | Socket for TX Recovery Manager                                              |
| TCP 4713      | Socket for TX Status Manager                                                |
| TCP 8080      | Master port for several types of communication                            |
| TCP 8443      | Socket for HTTPS communication                                              |
| TCP 8009      | Socket for AJP (web proxy)                                                  |
| TCP 9990      | Socket for HTTP Management Console                                          |
| TCP 9993      | Socket for HTTPS Management Console                                         |
| TCP 8787      | PTP 820 NMS Java remote debug port                                          |
TCP 61616 Used by the PTP 820 NMS client to connect to an enterprise messaging queue that runs within PTP 820 NMS, used to push events to the client about changes in services.

Reserving ports on the machine hosting the System Manager
The following ports need to be left empty on the machine hosting the System Manager so that the application can bind to them.

Table 13 Reserving ports on the machine hosting the System Manager

<table>
<thead>
<tr>
<th>Port</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TCP 18005</td>
<td>Shutdown port</td>
</tr>
<tr>
<td>TCP 18010</td>
<td>AJP connector port</td>
</tr>
<tr>
<td>TCP 18080</td>
<td>Connector port</td>
</tr>
<tr>
<td>TCP 18443</td>
<td>Redirect port</td>
</tr>
</tbody>
</table>

Changing TCP ports in PTP 820 NMS
The 8080 TCP port is the default port that the server exposes to clients (GUI, CLI reports, NIF Agent). This port needs to be added to the firewall setting (see Firewall settings).

If you wish to configure PTP 820 NMS to use other ports instead, you can change the PTP 820 NMS default settings, and specify which TCP ports should perform the PTP 820 NMS functions instead.

The following table lists the PTP 820 NMS modules that make use of this port, and describes in which configuration files and fields the port is defined.

Note that before changing the port, all modules relating to the port must first be stopped.

Table 14 PTP 820 NMS modules

<table>
<thead>
<tr>
<th>Module</th>
<th>File</th>
<th>Path to File</th>
<th>Field/Location in file</th>
<th>Default Port</th>
</tr>
</thead>
<tbody>
<tr>
<td>Polytopo import</td>
<td>config.properties</td>
<td>&lt;Install_path&gt;\PTP 820 NMS\PolyTopoImport\conf</td>
<td>topo.import.port</td>
<td>8080</td>
</tr>
<tr>
<td>NIF Agent</td>
<td>logininfo.properties</td>
<td>&lt;Install_path&gt;\PTP 820 NMS\Northbound SNMP\bin\conf</td>
<td>serverurl</td>
<td>8080</td>
</tr>
<tr>
<td>Server</td>
<td>standalone-ngnms.xml</td>
<td>&lt;Install_path&gt;\PTP 820 NMS\Server\wildfly-15.0.0.Final\standalone\configuration</td>
<td>&lt;socket-binding name=&quot;http&quot; port=&quot;${jboss.http.port:80 80}=&quot;/</td>
<td>8080</td>
</tr>
<tr>
<td>Client</td>
<td>NGnms.ini</td>
<td>&lt;Install_path&gt;\PTP 820 NMS\GUI_Client</td>
<td>nms_server_port</td>
<td>8080</td>
</tr>
</tbody>
</table>
### Windows Services and Server Monitor

At the end of an installation on Windows platform, the PTP 820 NMS Server is installed as a Windows service and a Server Monitor application is automatically started (look for the systray icon ). If you don't want the PTP 820 NMS Server to start automatically upon computer reboot, you can set the mode of the PTP 820 NMS Service to Manual in the Services applet in the Control Panel.

### Enable System Manager in Internet Explorer

To enable System Manager to open with Internet Explorer 11 following the completion of a PTP 820 NMS installation or upgrade, do the following:

- In Internet Explorer 11, add localhost, or the site where you installed the System Manager, to the Compatibility View. See the example below.

![Compatibility View Settings](image)
PTP 820 NMS Server Recommended Settings

PTP 820 NMS is predefined with default server settings for Maximum Connection Pool Size, Maximum Thread Pool Size, and Maximum Heap Size. These settings should be tuned on servers managing large networks. The following table presents the recommended settings for various network sizes:

<table>
<thead>
<tr>
<th>Network size</th>
<th>Max Connection Pool Size</th>
<th>Max Thread Pool Size</th>
<th>Heap Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>1000 NEs</td>
<td>250</td>
<td>100</td>
<td>3000</td>
</tr>
<tr>
<td>2000 NEs</td>
<td>300</td>
<td>130</td>
<td>5000</td>
</tr>
<tr>
<td>4000 NEs</td>
<td>500</td>
<td>250</td>
<td>10000</td>
</tr>
<tr>
<td>10000 – 20000 NEs</td>
<td>500</td>
<td>300</td>
<td>20000</td>
</tr>
</tbody>
</table>

To change these settings:

1. In the PTP 820 NMS System Manager: open the Settings menu and click **PTP 820 NMS Server**.
2. Change the value for Maximum Connection Pool Size, Maximum Thread Pool Size, and Maximum Heap Size according to the values in the table above.
   
   Note that the maximum allowed heap size is highly dependent on available memory on the server.

3. Restart PTP 820 NMS Server.
   
   - If the server fails to start, reset the values, as above, using lower values than the ones suggested.
   - If the server starts successfully, leave the server running or increase the values even further until server start failing. Then use the last values it successfully started with.

Server should now have an optimal configuration.
PTP 820 NMS Client memory allocation

The client by default is allocated 2GB of RAM. In large setups, follow these directives:

◦ For setups with over 5,000 devices, increase the memory allocation by an extra 1GB of RAM for each additional 5,000 devices. That is:
  ○ For a setup with 10,000 devices, allocate a total of 3GB of memory
  ○ For a setup with 15,000 devices, allocate a total of 4GB of memory
  ○ For a setup with 20,000 devices, allocate a total of 5GB of memory

◦ It is recommended to limit the number of devices managed by a single PTP 820 NMS client to 10,000 (5,000 is preferable) to avoid delays in screen update.

To change the memory allocation of the PTP 820 NMS client:

1. Open the file Ngnmns.ini located in <PTP 820 NMSInstallationFolder>/GUI_Client.
2. Replace -Xmx2048m with the appropriate value. For example:
   ○ -Xmx3062m (to allocate 3GB)
   ○ -Xmx4096 (to allocate 4GB)
3. Save the changes.

The new memory settings will go into effect when you restart the client.

PTP 820 NMS license

In order to run PTP 820 NMS, it is necessary to have a suitable license.

License installation for a new PTP 820 NMS installation

Following completion of PTP 820 NMS installation, System Manager is automatically launched and opens the NMS Initial Setup wizard, beginning with License Import. Note that License Import can also be performed from the System Manager’s Import License wizard.

Note: For a full explanation of System Manager, see the PTP 820 NMS User Guide.

To install a license:

1. In the System Manager’s Database tab, run the NMS Initial Setup wizard. Or in the System Manager’s License Administration tab, run the Import License wizard.
2 In the **Import License** window, click **Use Temporary License** to load the temporary license file provided with the installation.

**Figure 34** Import License window

3 A temporary license, which will expire in 30 days, is loaded. Copy the Activation key, appearing at the bottom of the Wizard’s Import License window. You will need to provide it when requesting a permanent license.

**Note:** At any point, you can view your Activation key in the System Manager’s License Administration tab.
4 Follow the instructions to complete the wizard.

5 The temporary license file is valid for 30 days. During that time, contact Customer Support to obtain a permanent license, and send them the Activation key you had noted in step (3). You will then be requested to send your business details.

6 When you receive the permanent license, run the Import License wizard to import the permanent license.

7 We recommend recording the License no. of the permanent license (displayed in the System Manager’s License Administration tab) and saving it in a safe place.

License installation when upgrading to a new PTP 820 NMS version

Every upgrade requires importing a license again. For minor version upgrade, the old license can be used; for major version upgrade, a new license must be requested.

To install a license:

1 Access the System Manager’s License Administration tab, and note down your current License No.
2 Contact Customer Support and send them the current License No.
   Specify also the PTP 820 NMS version to which you wish to upgrade.

3 When you receive the new permanent license, compatible with the PTP 820 NMS version to which
   you wish to upgrade, save it on your system.

4 After upgrading PTP 820 NMS to the new version, run the System Manager’s NMS Initial Setup
   wizard, and Import the new permanent license.

License installation when upgrading license capabilities
If you are upgrading your license capabilities, such as adding a new High Availability feature, do the
following:

1 Access the System Manager’s License Administration tab, and note down your current License No.

2 Contact Customer Support and send them your current License No.
   Specify also which capabilities you are adding.

3 When you receive the new permanent license, compatible with the new capabilities, save it on your
   system.

4 Run the Import License wizard to Import the new permanent license.
License installation following hardware replacement

If you wish to install PTP 820 NMS on a different machine, do the following:

1. Before you uninstall PTP 820 NMS from the current machine, access the System Manager’s License Administration tab, and note down your current License No.

   ![Figure 37 License installation following hardware replacement](image)

2. After installing PTP 820 NMS on the new machine, run the System Manager’s NMS Initial Setup wizard or Import License wizard, and perform the following:
   
   - i. In the Import License window, click Use Temporary License to load the temporary license file provided with the installation.
   
   - ii. A temporary license, which will expire in 30 days, is loaded. Copy the Activation key, appearing at the bottom of the Wizard’s Import License window. You will need to provide it when requesting a permanent license.
   
   - iii. Follow the instructions to complete the wizard.

3. The temporary license file is valid for 30 days. During that time, contact Customer Support to obtain a permanent license and send them:
   
   - i. The old permanent License No. you had noted in step (1).
   
   - ii. The new Activation key from the reinstallation, noted in step (2) (ii).

4. When you receive the new permanent license, save it on your system.

5. Run the Import License wizard to Import the new permanent license.

PTP 820 NMS GUI Client

Start the PTP 820 NMS Client from the program shortcut folder selected during the installation process. A Login window will be displayed where the authentication credentials and the server host name must be entered.

The authentication credentials for the root administrator are:

User name: root
Password: pw
Note: It is strongly recommended to change the password of the root account immediately after the first login to prevent unauthorized access. To change the password, open the User Settings preferences menu.

The next step is now to discover your network, as described in the PTP 820 NMS NMS User Guide.

Database administrator user privileges

In order to be able to run the wizards that can be found in the Database Task view in the PTP 820 NMS System Manager on an Oracle database, you need to create database users with sufficient privileges to perform the tasks. The required privileges are listed in Creating an additional Oracle custom DBA user.

Oracle 12c - Adding missing admin privileges to the existing SYSTEM user

In Oracle 12c, instead of creating a new Oracle admin user, you can grant an existing Oracle system user all the required privileges needed to administrate the PTP 820 NMS Oracle database. To do so:

1. Launch an Oracle database utility such as SQLPLUS and log into the Oracle database with SYSDBA privileges.

   For example in SQLPLUS, enter the following in the command prompt:

   sqlplus SYSTEM AS SYSDBA/password@sid.

2. Grant to an existing SYSTEM user the required admin privileges by running the following:

   GRANT SELECT ON SYS.USER$ to system;
   Commit;

Setting the device Backup Configuration and Software Images repository folder

You can set the name and location of the PTP 820 NMS repository folder that contains the following two subfolders:

- SoftwareImages – stores device software images
- BackupConfigurations – stores device configuration backups

By default, this repository folder is <system-user-dir>:\NgNMS for Windows and /NgNMS/ for Solaris. You can change the folder name and path to a new path on a local drive only – you cannot specify a shared network storage or external drive.

To set the BackupConfiguration and SoftwareImages repository folder:

1. Create the new folder and path in the desired local drive location.

2. Specify the new folder name and path in the relevant config file, as follows:

   i. In the PTP 820 NMS server machine, navigate to <server installation folder>\Server\wildfly-15.0.0.Final\standalone\configuration\. (By default, the server installation folder is C:\Program Files\PTP 820 NMS.)

   ii. Open the config file config_folder_location.properties with a text editor.

   iii. In the config file, enter the new folder name and path after the equal sign in backup.rootfolder=
• If the server is a Windows machine, use double slashes instead of single slashes when specifying the path. For example, `C:\Backup_Repository_Folder`.

  o If the server is a Solaris machine, make sure there are no spaces in the string you enter.

**Note**: If you specify a folder and path that you did not create, or which you do not have permission to access, the default folder and path will be used.

3 If you have any folders and files in the BackupConfiguration or SoftwareImages folders under the default repository folder (C:\NgNms), manually move them, while preserving their directory structure, to the new repository folder. Otherwise, you will not be able to manage those files through the PTP 820 NMS GUI.

4 Restart the PTP 820 NMS server.

5 In a PTP 820 NMS Server High Availability setup, perform steps 1 – 4 in both the Primary and Secondary servers.

6 Verify that PTP 820 NMS is using the new repository folder, as follows: Create a device configuration backup or download a device software image (as described in the *PTP 820 NMS NMS User Guide*), and verify that the configuration backup is located in the BackupConfigurations subfolder of the new folder, and the software image is located in the SoftwareImages subfolder of the new folder.

**Maintenance issues**

PTP 820 NMS Server generates various log files. These files tend to grow large when managing networks with many elements and heavy traffic.

**Delete old server log files**

Locate your PTP 820 NMS log file directory and remove all files older than three months:

**Installation directory:**

```plaintext
<PTP 820 NMS installation>\Server\wildfly-15.0.0.Final\server\ngnms\log
```

Example for Windows:

```plaintext
C:\Program Files\PTP 820 NMS\Server\wildfly-15.0.0.Final\server\ngnms\log
```

**Backup important files and folders**

A full system recovery is likely to take less time if these files and folders are backed up regularly:

• License file for PTP 820 NMS:

  ```plaintext
  <PTP 820 NMS installation>\Server\wildfly-15.0.0.Final\server\ngnms\license\sw-nms.key
  ```

• Database server connection parameters and other settings (also copy sub folders):

  ```plaintext
  <PTP 820 NMS installation>\SystemManager\conf\*
  ```

• Database backup files. Can be stored on user configurable folders. Default folder for Windows is: `C:\NgNMS\backup\database`

  Default folder for Solaris is: `/usr/PTP 820 NMS/backup/database`
Chapter 3: PTP 820 NMS Server High Availability

Server High Availability is intended to ensure continuous PTP 820 NMS operation. PTP 820 NMS also offers a Database High Availability option, which can be implemented if Server High Availability is implemented. For information about database high availability, refer to PTP 820 NMS Database High Availability.

In a server High Availability setup, two PTP 820 NMS servers (called mates) are configured so that one is the Primary server, and the other is the Secondary server.

At any given time only one of the two servers is Active and the other is on Standby. The Active server can both read from and write to the database, while the Standby can only read from the database. PTP 820 NMS clients are always connected to the Active server.

The Primary server is the Active server unless it has stopped. If the Primary server is stopped, the Secondary server becomes the Active server and the Primary server becomes the Standby server. When the Primary server is restarted, it switches back to being the Active server (after a pre-configured grace period), and the Secondary server switches back to being the Standby server.

Note: Many of the tasks detailed in the following sub-sections are performed in System Manager. See the PTP 820 NMS User Guide for a detailed explanation of System Manager and how to use it.

Database architecture supporting server High Availability

The Server High Availability solution supports the following database architectures:

- A single Relational Database Management System (RDBMS) and single database - Postgres or Oracle.
- Multiple RDBMS and single database - using Oracle RAC.
Prerequisites to configuring Server High Availability

Before configuring server high availability, make sure you meet the following prerequisites:

- You must obtain a license with a server High Availability feature for each of the two servers.
- The license settings on both servers must be identical.
- The Operating System on both servers must be identical: either both Solaris or both Windows.
- Both PTP 820 NMS servers participating in a server high availability setup in a Solaris environment must run the same version of Solaris. You must verify this yourself, as this is not checked by the application. Full server high availability functionality is provided whether both PTP 820 NMS servers run Solaris 10 or Solaris 11.
- The PTP 820 NMS version to be installed on both servers must be identical.
- Both servers must use the same user/schema.
- Both servers should be set up as Trap Managers.
- Northbound interface should be configured for both servers. In both servers, the NG NMS SNMP Agent service should be set (in the operating system's Services) to start automatically upon a server restart.
- Ensure that the UTC time on both servers is the same.
- System Manager must be installed on all servers in which a PTP 820 NMS server and/or database are installed.

PTP 820 NMS Configuring Server High Availability

Initial setup of PTP 820 NMS servers participating in server High Availability

After meeting the Prerequisites to configuring Server High Availability, perform initial setup of the PTP 820 NMS servers intended to participate in a server High Availability setup, as described in the following sub sections.

For single RDBMS using Postgres or Oracle

When installing the Primary server:

When installing the PTP 820 NMS server intended as the Primary server:

1. In the User/Schema Parameters page of the Initial Setup wizard, select to use a New database user/schema and enter the user/schema username and password.
Figure 38 User/Schema Parameters page

User/Schema Parameters (4/7)

The fields marked with * are required.

Enter a new NMS user/schema name and password.
If the user/schema is an older version, it will be upgraded to the current version.

- New database user/schema
- Existing database user/schema

Username:*  nms
Password:*  
Confirm password:*
2 After setup is complete, uncheck the **Start NMS Server** checkbox.

**Figure 39** Start NMS Server checkbox
When installing the Secondary server:

When installing the PTP 820 NMS server intended as the Secondary server:

1. In the Database Connection Parameters page of the Initial Setup wizard, enter the address of the same database used by the primary server.

   Figure 40 Database Connection Parameters page

   ![Database Connection Parameters](image)

2. In the User/Schema Parameters page of the Initial Setup wizard, select to use an **Existing database user/schem**a, and enter the user/schema username and password you specified during Primary server setup.

3. After setup is complete, uncheck the **Start NMS Server** checkbox.

For multiple RDBMS using Oracle RAC

**Note:** Oracle RAC 12 is not supported.

In a server High Availability setup, Oracle RAC is only supported for PTP 820 NMS servers in a Solaris environment.

When installing each of the two PTP 820 NMS servers which will participate in a server High Availability setup, do the following:

1. In the Database Connection Parameters page of the Initial Setup wizard:
i Set the **Database instance name** to the Service Name configured for RAC.

ii Set the **Database type** to Oracle.

iii In the **Database server address** field, instead of entering an address, enter the DNS address of the RAC instances (all the nodes on which RAC is installed are configured in the DNS). The rest of settings are the same as for regular databases.

![Figure 41 Database server address field](image)

2 After setup is complete, uncheck the **Start NMS Server** checkbox.

**Enabling Server High Availability**

After performing [Initial setup of PTP 820 NMS servers participating in server High Availability](PTP 820 NMS Configuring Server High Availability), configure server High Availability as follows:

1 Run System Manager for both servers (see the *PTP 820 NMS User Guide* for a detailed explanation of System Manager and how to use it).

2 Stop both servers by pressing **Stop** in the Dashboard View of their System Managers.

3 Ensure there is connectivity between the two System Managers.

4 For each of the two servers, load a license in which High Availability is enabled, and run one of the following:
• Import License Wizard to import a new license into PTP 820 NMS.
• Update Capabilities wizard to invoke the additional capabilities provided by a new imported license.

5 Configure secure communications between the machine hosting the Primary server and the machine hosting the Secondary server, as described in Setting up secure communications between the two mate machines. This will enable file synchronization for server High Availability.

6 In the NMS HA View of the Primary server’s System Manager:
   i Set the Server Mode to Primary.
   ii Optionally change the default settings of the Automatic Switch Time and Time for sync file system fields.
   iii Specify the IP address of the Secondary server in the Mate Server IP field.
   iv Specify a domain username of the mate server in the Mate Username field.

   **Figure 42 NMS HA View of the Primary server’s System Manager**

7 In the same NMS HA View, click Generate Keys, and confirm you wish to generate new security keys.
   • This generates a pair of security keys (private key and public key) for encrypting communications between the Primary server’s system manager and the Secondary server’s system manager.

   The keys are placed in the `SystemManager\conf\keys` subfolder of the PTP 820 NMS server installation folder. For example:
   - `C:\Program Files\PTP 820 NMS\SystemManager\conf\keys`
in a Windows installation.
Chapter 3: PTP 820 NMS Server High Availability

PTP 820 NMS Configuring Server High Availability

8 Copy the entire keys subfolder to the SystemManager\conf\ subfolder of the Secondary server’s installation folder.

9 In the NMS HA View of the Primary server’s System Manager, press Save.
   If the HA configuration completes successfully, no error messages appear, and the Save button is greyed out.
   If the following error is displayed in the dashboard: Something went wrong during mate verification, this indicates that there is a problem/inconsistency with the configuration between the two servers. In that case, verify the following at the Secondary server:
   - Connectivity with the mate
   - Connectivity with DB
   - The correct keys were copied to the correct location

10 In the Dashboard View of the Primary server’s System Manager, verify that HA Configuration Status is Configuration saved. Note:
    - In the Dashboard View of the Primary server, the HA State will be Active.
    - In the Dashboard View of the Secondary server, the HA State will be Standby.

11 Start the Primary and Secondary servers, by pressing Start in the Dashboard View of their System Managers. You must start the Primary server first, and wait until it is up and running before starting the Secondary server.
   Note that in any case where you need to start both the Primary and Secondary servers, you must start the Primary server first, and wait until it is up and running before starting the Secondary server.

12 When logging in, enter in the Server field the addresses of both the Primary and the Secondary servers, separated by a semicolon.

Note: Make sure to configure backup of the Primary and Secondary servers, in System Manager, at different, non-overlapping times.
Setting up secure communications between the two mate machines

After Enabling Server High Availability, set up secure communications between the two mate machines as described in this section.

To enable file synchronization in a server High Availability setup, you need to setup secure SSH communication between the two machines on which the mates are installed. The following sections describe how to setup SSH communication in a Windows operating system and in a Solaris operating system.

Note that during synchronization, all PTP 820 NMS-related files under the NgNMS folder are copied to the other server under the same folder hierarchy.

- In Windows, the folder path is c:\NgNMS
- In Solaris, the folder path is /usr/NgNMS

Note also that PTP 820 NMS-related files have unique names. Any user files that are not uniquely named may be overwritten.

Securing communications between mates on Windows

1. On both mate machines, install Cygwin under C:\cygwin with the following packets: unzip, zip, openssh, openssl and rsync. Refer to http://docs.oracle.com/cd/E24628_01/install.121/e22624/preinstall_req_cygwin_ssh.htm#EMBSC281.

2. Open the Cygwin terminal as an Administrator, and configure and start the SSH service as follows (refer also to https://docs.oracle.com/cd/E24628_01/install.121/e22624/preinstall_req_cygwin_ssh.htm#EMBSC281):
   i. Configure the SSH service by executing: ssh-host-config.
      Enter No in response to the query: Do you want to use a different name? (yes/no)
   ii. After setting up the SSH service the following message should appear: Host configuration finished. Have fun!
   iii. Start the SSH service by executing the following command:
        cygrunsrv -S sshd

3. Configure SSH to work between the two mates without a password, by performing the following in each of the two mate machines:
   i. Generate a pair of RSA keys without a password, using the following Cygwin command: ssh-keygen –t rsa.
   ii. The keys are saved in the default folder /home/<user folder>/.ssh/

4. Copy the public key of each mate machine to the other mate machine, as follows:
   i. In one machine, open the id_rsa.pub file with a text editor, and copy its content, which is this machine’s public key.
   ii. In the other machine, create an authorized_keys file under C:\cygwin\home\<user folder>\ssh\ and paste the copied public key into the file.
5 If any of the mate machines has SFTP installed, change the default SSH port 22 to another unused port in each mate machine's `SSH_config` and `SSHD_config` files (standard busy ports can be found in: [https://en.wikipedia.org/wiki/List_of_TCP_and_UDP_port_numbers](https://en.wikipedia.org/wiki/List_of_TCP_and_UDP_port_numbers)). Both mates must use the same SSH port number.

6 In each of the two machines, connect from one computer to another via SSH using: `ssh <username>@<ip>`. This adds the host to the `known_hosts` list. Login should work automatically, without requiring you to enter a password.

7 In each of the two machines, create a home user directory for the SYSTEM user as follows:
Under C:\cygwin, create a root subfolder, and under root create a .ssh subfolder.

8 Make the owner of the root folder the SYSTEM user by executing the following Cygwin commands:
`chown SYSTEM /root` and `chown SYSTEM /root/.ssh`.

9 In each of the two machines, copy the private and public keys and the `known_hosts` file to the `root/.ssh/` directory by copying the id_rsa.pub file, the id_rsa file and the known_hosts file from C:\cygwin\home<user folder>.ssh into the C:\cygwin\root\ssh folder you created in step (7).

10 In each of the computers, modify the password file in C:\cygwin\etc\passwd as follows:
In the line that starts with SYSTEM insert /root before the last colon on the line, and the append /bin/bash after the last colon on the line.
For example:

   SYSTEM:*:18:18:U-NT AUTHORITY\SYSTEM,S-1-5-18:/root:/bin/bash

11 If a passwd file does not exist in the C:\cygwin\etc\ folder, you need to create it by creating in the C:\cygwin\etc\ folder a new file named passwd (without an extension), and then executing the following command in the Cygwin terminal:

   `mkpasswd -l >> /etc/passwd`

Securing communications between mates on Solaris

1 On each mate machine, install rsync with all its dependencies, either in /usr/bin/ or in /usr/sbin/. Alternatively, create in one of these two folders a symbolic link to the actual installation folder.

2 Configure SSH to work between the two mates without a password, by generating a pair of RSA keys without a password, in each of the two mate machines.

3 Copy the public key of each mate machine to the other mate machine, as follows:
   i In one machine, open the id_rsa.pub file with a text editor, and copy its content, which is this machine's public key.
   ii In the other machine, create an authorized_keys file under /.ssh/ and paste the copied public key into the file.

4 If any of the mate machines has SFTP installed, change the default SSH port 22 to another unused port in each mate machine's `SSH_config` and `SSHD_config` files (standard busy ports can be found in: [https://en.wikipedia.org/wiki/List_of_TCP_and_UDP_port_numbers](https://en.wikipedia.org/wiki/List_of_TCP_and_UDP_port_numbers)). Both mates must use the same SSH port number.
Both mates must use the same SSH port number.
5 In each of the two machines, connect from one computer to another via SSH using: ssh <username>@<ip>.
   This adds the host to the known_hosts list. Login should work automatically, without requiring you to enter a password.
6 In each machine, test rsync as follows: type rsync into a terminal window, and make sure the command is recognized. If instead a command not found message appears, add rsync to the PATH variable by appending /usr/bin/ or /usr/sbin/ to the PATH variable.

Upgrading a Server High Availability setup

To perform an upgrade in a setup configured for both PTP 820 NMS Server High Availability and PTP 820 NMS Database High Availability, refer to Upgrading a Database High Availability setup.

To perform an upgrade in a setup configured only for PTP 820 NMS Server High Availability (and not configured for PTP 820 NMS Database High Availability), follow the instructions in this section.

Upgrading a Server High Availability setup in a Windows environment

Both PTP 820 NMS servers participating in a server high availability setup must run the same software version. Therefore, to upgrade the PTP 820 NMS versions of two PTP 820 NMS servers in a High Availability configuration, you must perform the following:
1 In both servers, follow the instructions listed in Before upgrading in Windows.
2 Stop both servers; first the Standby and then the Active.
3 Upgrade to the new PTP 820 NMS version on both servers, by following the instructions in Performing an upgrade in Windows.
4 In the Primary server open System Manager and follow the database upgrade process that starts automatically. Note that the database used prior to the upgrade, will be automatically selected and upgraded. At the end of the wizard, uncheck the Start NMS Server checkbox before closing the wizard.
5 In the Secondary server open System Manager and follow the database upgrade process that starts automatically. The database will not be upgraded, since this was done during upgrade of the Primary server (in the previous step 4). At the end of the wizard, uncheck the Start NMS Server checkbox before closing the wizard.
6 Configure Server High Availability as described in Enabling Server High Availability.
7 Start the primary server.
8 Start the secondary server.
Upgrading a Server High Availability setup in a Solaris environment

For the Solaris platform, this version of the installer supports only new installations, no Upgrade or Maintenance. This means that you must uninstall the current version before installing a new version. Uninstalling the version will not affect the information in the database, which will be maintained. The database will be upgraded when following the process described below:

1. In both servers, follow the instructions listed in Before upgrading in Solaris.
2. Stop both servers; first the Standby and then the Active.
3. Uninstall PTP 820 NMS from both servers.
4. Install the new PTP 820 NMS version on both servers, by following the instructions in New Solaris Installation.
5. On both servers, open System Manager and the Initial Setup wizard opens automatically. In the Initial Setup wizard, complete initial setup by following the wizard, taking care to perform the following:
   - In the Import License page, import the new license.
   - In the User/Schema Parameters page, select existing database user/schema and specify the existing database. This will automatically upgrade it.
   - Use the same database schema for both servers.
   - At the end of the wizard, uncheck the Start NMS Server checkbox before closing the wizard.
6. In the primary server, configure Server High Availability as described in Enabling Server High Availability.
7. Start the Primary server if it is not running.
8. Start the Secondary server if it is not running.
Database High Availability is intended to ensure continuous PTP 820 NMS database operation. Database High Availability requires that PTP 820 NMS Server High Availability also be enabled.

PTP 820 NMS offers a database high availability setup, in which two PTP 820 NMS databases are configured so that one is the Active database, and the other is the Failover database.

At any given time only one of the two databases is active. If the machine hosting the active database is stopped, the server detects the failure and switches to the other (failover) database which then becomes the active database. This switchover may take up to 10 minutes. When the machine that stopped is restarted, the database on that machine becomes the failover database.

In a database high availability setup, the currently active database is regularly replicated to the failover database. You can set the replication frequency, with the default frequency being once a day.

Note: Many of the tasks detailed in the following sub-sections are performed in System Manager. See the PTP 820 NMS User Guide for a detailed explanation of System Manager and how to use it.

Database High Availability supported configurations

The active and failover databases may be installed in either of the following configurations:

- **2 + 2**: Installation includes four different nodes: one hosting the PTP 820 NMS Active Server, a second hosting the PTP 820 NMS Standby Server, a third hosting the Active database, and a fourth hosting the Failover database. In this configuration the operating system can be Windows or Solaris and the database must be PostgreSQL.

- **1 + 1**: The active and failover databases are installed on the same machines hosting the PTP 820 NMS Active and Failover servers. That is, installation includes only 2 nodes: one machine hosting the PTP 820 NMS Active Server and one database, and a second machine hosting the PTP 820 NMS Standby server and the second database. 1 +1 configuration is supported only if the machines’ operating system is Windows, and the databases are PostgreSQL.

Prerequisites to configuring Database High Availability

Before configuring database high availability, make sure you meet the following prerequisites:

- In the current PTP 820 NMS release, database high availability requires that PTP 820 NMS Server High Availability also be enabled.

- In the current PTP 820 NMS release, database high availability requires that the database be a Postgres database. The PTP 820 NMS server can be installed either on a Windows or on a Solaris machine.

- Both the Active and the Failover databases must be the same Postgres 9.4.x version.
• Both the Active and Failover databases, as well as the Primary and Secondary PTP 820 NMS servers, must be running on machines having the same type of operating system (either all Windows, or all Solaris).

• Both the Active and the Failover databases must use the same database encoding method: UTF8 or ASCII. Encoding is set during database creation; instructions for how to set the encoding method can be found on the Postgres support site.

• The Active and Failover databases must have different names.

• The Active and Failover databases must be installed in one of the configurations described in Database High Availability supported configurations.

• System Manager must be installed on all servers in which a PTP 820 NMS server or database are installed.

• On both the Active and the Failover database machines, make sure that you add to the pg_hba.conf file the IP addresses of the Active and Failover database machines, and of the Primary and Secondary PTP 820 NMS servers.
  For example:

  host  all    all    1.1.1.0/32    md5
  host  all    all    1.1.1.1/32    md5
  host  all    all    1.1.1.2/32    md5
  host  all    all    1.1.1.3/32    md5

  Where 1.1.1.0 is the IP address of the Active database machine, 1.1.1.1 is the IP address of the Failover database machine, 1.1.1.2 is the IP address of the Primary Active PTP 820 NMS server, and 1.1.1.3 is the IP address of the Secondary Standby PTP 820 NMS server.

Configuring PTP 820 NMS Database High Availability

After meeting the Prerequisites to configuring Database High Availability, perform initial setup of PTP 820 NMS databases intended to participate in a database high availability setup, as described in the following sub-sections.

Defining the Active and Failover databases

Before performing the procedure described in the section, the two databases must already be installed and properly configured, either on the same machines as the PTP 820 NMS servers (a 1 + 1 configuration), or on separate machines (a 2 + 2 configuration).

Note: The procedure described in this section must be performed identically in the System Manager of each of the two mate PTP 820 NMS servers.
1. On the System Manager of the PTP 820 NMS server, define the active database, as follows:
   i. In the Introduction page of the Set Active/Failover User/Schema wizard, set **Operation type** to **Set Active User/Schema**.

   **Figure 43 Set Active User/Schema**
ii In the Database Connection Parameters page, make sure the **Database server address** of the active database is entered as an IP address, and not **localhost**.

**Figure 44** Database Connection Parameters page

iii In the Database Install Path page, specify the active database installation folder. The default location for Windows is 
C:\Program Files\PostgreSQL\9.x\bin
The default location for Solaris is: /usr/postgres/9.x/bin/64. Note that for Solaris, this path must be manually added.

**Figure 45** Database Install Path page
2 On the System Manager of the PTP 820 NMS server, define the failover database, as follows:

i In the Introduction page of the Set Active/Failover User/Schema wizard, set **Operation type** to **Set Failover User/Schema**.
In the Database Connection Parameters page, make sure the **Database server address** of the failover database is entered as an IP address, and not **localhost**.

iii In the Database Install Path page, specify the failover database installation folder. The default location for Windows is 
\[ C:\Program Files\PostgreSQL\9.x\bin \]
The default location for Solaris is: 
\[ /usr/postgres/9.x/bin/64. \]
Note that for Solaris, this path must be manually added.

**Defining the Database Replication Frequency**

On the System Manager of the PTP 820 NMS server, set the database replication frequency as described in this section. Note that replication is always made from the currently Active database to the current Failover database.

**Note:** The procedure described in this section must be performed identically in the System Manager of each of the two mate PTP 820 NMS servers. The reason is that although replication is performed only on the Primary server, following a switchover the Secondary server becomes the Primary server.

**Note:** For a setup with a large database, see the database replication recommendations in **Database High Availability – performance considerations**.
1. In the Backup Active User/Schema page of the Backup Active User/Schema wizard:
   i. Select the **Schedule Backup** checkbox, and set the Start date and time, as well as the frequency of the periodic backup. The frequency settings apply also to database replications.
   ii. Select the **Database Replication backup** checkbox. The replication frequency you set will apply to the database that is the active database at the time replication occurs.

**Figure 46** Backup Active User Schema

---

**Backup of the Active database in Database High Availability setup**

This section describes the steps required for scheduling an automatic backup of the Active database. Active database backup is a separate task than the database replication and provides extra protection in case of failures.

In a Database High Availability setup, it is recommended to create backups only for the Active database. PTP 820 NMS knows which is the Active database at any given moment – either the Primary or the Secondary database.
Chapter 4: PTP 820 NMS Database High Availability

Backup of the Active database in Database High Availability setup

**Note:** For a setup with a large database, see the database backup recommendations in Database High Availability – performance considerations.

1. On the System Manager of the Primary PTP 820 NMS server, create a scheduled Active database backup, as follows:
   i. In the Introduction page of the Backup Active User/Schema wizard, press **Next**.
   
   ![Backup Active User/Schema](image)

   ii. In the Backup Active User/Schema page, enter the database installation path, select the **Schedule Backup** checkbox, set the Start date and time as well as the frequency of the periodic backup, and press **Schedule**.

   **Note:** Do not select the Database Replication backup checkbox, because you are now not setting the Replication frequency for the Database High Availability function.
Keep in mind:

- It is recommended to run the Backup task first and then the Replication task.
- Make sure that there is a large enough time interval between the Backup task and the Replication task in order to avoid tasks overlaps. In large setups (over 5K NEs), at least 4 hours between the tasks is recommended.

Database High Availability – performance considerations

For large setups having a large database, the Backup of the Active database and Database Replication operations should NOT be scheduled during night time, so as not to affect the nightly poll.

We recommend setting the following schedule:

- Replicate Active database – set to 08:00 daily
- Backup Active database on Primary (Active) Server – set to 14:00 daily
- Backup Active database on Secondary (Stand-by) Server – set to 16:00 daily

Upgrading a Database High Availability setup

Upgrading a Database High Availability setup in a Windows environment

1. In both servers, follow the instructions listed in Before upgrading in Windows.
2. Stop both servers; first the Standby and then the Active.
3 Install the new PTP 820 NMS version on the Primary/Active server by following the instructions in "Performing an upgrade in Windows."

4 Install the new PTP 820 NMS version on the Secondary/Stand-by server by following the instructions in "Performing an upgrade in Windows."

5 In the Primary server open System Manager and the Initial Setup wizard opens automatically. In the Initial Setup wizard, complete initial setup by following the wizard, taking care to perform the following:
   - At the end of the wizard, uncheck the Start NMS Server checkbox before closing the wizard.

6 In the Secondary server open System Manager and the Initial Setup wizard opens automatically. In the Initial Setup wizard, complete initial setup by following the wizard, taking care to perform the following:
   - At the end of the wizard, uncheck the Start NMS Server checkbox before closing the wizard.

7 In the Primary server open System Manager, and in Database Tasks select to run the Upgrade User/Schema wizard. Specify the Failover database scheme and follow the wizard to upgrade that database. (Note that the Active database was upgraded when you ran Initial Setup on the Primary server, in step (5) above.)

8 Start the Primary server.

9 Start the Secondary server.

**Upgrading a Database High Availability setup in a Solaris environment**

1 In both servers, follow the instructions listed in "Before upgrading in Solaris."

2 Stop both servers; first the Standby and then the Primary.

3 Uninstall PTP 820 NMS from both servers as described in "Uninstall PTP 820 NMS for Solaris."

4 Install the new PTP 820 NMS version on both servers.

5 In the server you wish to designate as Primary (which we now call the *first* server), open System Manager and the Initial Setup wizard opens automatically. Complete initial setup by following the wizard, taking care to perform the following:
   - In the User/Schema Parameters page, select existing database user/schema and specify the previous Active database. This will automatically upgrade it.
   - At the end of the wizard, uncheck the Start NMS Server checkbox before closing the wizard.

6 In the server you wish to designate as Secondary (which we now call the *second* server), open System Manager and the Initial Setup wizard opens automatically. Complete initial setup by following the wizard, taking care to perform the following:
   - In the User/Schema Parameters page, select existing database user/schema and specify the previous Active database. The wizard will detect that it is already upgraded.
   - At the end of the wizard, uncheck the Start NMS Server checkbox before closing the wizard.

7 In the first server open System Manager, and in Database Tasks select to run the Upgrade User/Schema wizard. Specify the previous Failover database scheme and follow the wizard to upgrade that database. (Note that the Active database was upgraded when you ran Initial Setup on the first server, in step (5) above.)
8 In the first server’s System Manager, set the database replication schedule as described in Database Replication.

9 In the first server, configure Server High Availability as described in Enabling Server High Availability, while taking care to set the first server as Primary and the second one as Secondary.
   • Make sure secure communication is still working between the two servers (see Securing communications between mates on Solaris).

10 Start the Primary server if it is not running.

11 Start the Secondary server if it is not running.